I'm not a robot



https://bozonebabi.nurepikis.com/427526043474403159368146938732435696821958?vutezokewusagodevaxososesowa=pegepexivozekorimavipadamotusovanabomawesivevorixawimasowusolobanogawowimogevugatagenagunekosomovotokixijujozijalupowenatexixugovupidaradazugoligetikizelavukagawosixawovuritimejexipudafenomuvivilulawetarox&utm_term=outlook+tips+and+tricks+presentation&biwobinuxutepisezapodozidogufisit=sawenaxuwotirekamiluwulokizeguduzovegosavatuxagelumitikomibupozofagudulojulerapozetewafupawibisuzulekopepimekimex































Outlook helps millions of people manage their email correspondence every day, but assumes you already know how to organize your office correspondence for optimal productivity. What if you don't? In this article, well give you some of the best Outlook hacks for digital office management, along with some awesome Outlook tips and tricks featured in
the program. My first rule of Office Management is: work less. Sounds like a perfect solution for all of us, but what does that look like in reality? Working less means you touch each piece of correspondence one time only. Whether its an actual paper envelope with a letter or whether its an email. Touch it once, handle it once, and move on.
Correspondence means Incoming Information, not necessarily follow-up tasks. Let's get started with some tips on email filing. Want to learn more? Take your Microsoft Office skills to the next level with our comprehensive (and free) ebook! 1. Automatically file an email To apply the Work Less theory, have Outlook automatically file an email. Then you
can read them all at one time without distraction. Create a Folder: Ctrl + Shift + E Automate Filing into the folder Right-click the Email, click Rules, Choose Always move messages from And select your new folder 2. Use Favorites to keep active folders at the top of your Navigation Pane (aka folder pane) In the days of paper offices (pre-computer
age), we had 3 filing systems. These still apply to todays world but have been lost in the flurry of digital organizing. Active files These are your active customers, the most urgent vendors, you name it. These are the files you need at your fingertips. So we dont file them into the A-Z folder system; instead, we keep them handy in the Favorites folder at
the tip-top of the Outlook Navigation Pane. To add a folder to the Favorites, right-click the Folder and choose Show in Favorites When you are done with that project, simply right-click the Folder and choose Remove from Favorites Inbox folder system The second file system was contained in the old and dreaded 4-Drawer File Cabinets. (I still cringe at
the memory of those heavy, metal drawers slamming shut.) Well, these have essentially become the Inbox folder system which automatically alphabetizes the folders. What if youd like to cheat and move a W folder to the top of the Inbox list, but you cant pick it up and move it there? Heres a tip Just type an underscore, , or a number in front of the
folder name. You see, since computers auto-file for us, no one remembers or teaches the old rules of filing: Symbols and numbers come before everything else". Perennial files The third office file system is the Perennial file and Im not talking about flowers here. Perennial means forever files. You just dont purge these - EVER. These would be your
Archive Folders at the bottom of the Navigation (Folder) Pane. They would probably contain contract files, corporate records, tax records, etc. 3. Use Flags and Categories to keep track of important emails in your Inbox I once taught at a company that had color-coded their internal departments but didnt apply the same system to their emails. The
Categories inside your inbox can serve that purpose. Here is a quick video on how to Flag emails so they dont get lost and how to add color categories using the Categories column. 4. Use shortcuts The second rule of Office Management: Type less (and use shortcuts.) Here are some easy-to-remember options: Reply to an email: Ctrl + R To create a
new email: Ctrl + Shift + M To openyour email:Ctrl + 1 To openyour calendar:Ctrl + 2 To openyour contacts:Ctrl + 3 To openyour tasks:Ctrl + 4 Or use Quick Steps to pre-format and pre-address an email to multiple people. Want more Microsoft Office shortcuts? Check out our shortcuts for Word, PowerPoint, and Excel. 5. Drag and drop Third rule
of Office Management: Be open to learning new tricks! These little-known methods can surprise even the pros: Lets face it typing creates typos, which cause repair work and drain your productivity. When an email requires a task or follow-up, (i.e.: a contact needs to be created or an appointment is needed based on the information in the email), use
the Drag-And-Drop method below: (Mail, Calendar, Contacts, Tasks, or Notes) Drag and Drop: Simply click and drag the email and drop it onto the bottom left Contacts symbol on the Navigation bar. Suddenly youve got a brand new contact with the email address and name automatically entered. Now, inside the Contact window, the Notes portion
will have the persons phone # and address (if included on their signature line.) Use Copy (Ctrl C) and Paste (Ctrl V) to get the signature line items into the correct fields in the new contact window. Less typing, no typos, and your contact is created within seconds! Drag and Drop: the email again onto your Calendar and an appointment will be made.
Plus, it keeps all the detail from the email. So you wont have to re-type into the appointment. Drag and Drop an email onto the Tasks or Notes symbols on the Navigation bar. You can also reverse this: Drag any Contact to Mail on the Folder Pane to create a new email to that contact. Drag any contact to Calendar to create a new appointment Drag any
contact to Tasks 6. View the calendar and inbox side by side Save your sanity and move the Calendar to your second monitor to easily view both screens side-by-side. Right-click any of the bottom buttons on the Navigation Pane (aka Folder pane) (Mail, Calendar, Contacts, Tasks, or Notes) Choose Open in New Window Now drag that window onto
your second monitor Want more Outlook hacks? These tips in this article are just the beginning of the tips and tricks to simplify your office management while using Outlook. Ive used and taught Outlook for 10+ years, and just last month yes even I learned a new trick. Check out our full Microsoft Outlook course and you will learn so much more about
managing your digital office with Outlook! Ready to master Microsoft Office? Start learning for free with GoSkills courses Start free trial Microsoft Outlook is a popular desktop email program used by corporations and individuals alike. It's a powerful system, capable of managing many different email accounts, calendars, contact lists, and task lists.
Use these tips and tricks to make youremail tasks in Outlook more efficient and productive.Information in this article applies to Outlook 2019, 2016, 2013, 2010; Outlook for Microsoft 365, Outlook for Mac, and Outlook Online. While you are away from the computer, Outlook can automatically reply to incoming mail with a message telling senders
when youll be able to reply individually. Set up a short piece of text containing essential contact information, a tag line, or maybe an ad or quotation and insert this information in every email you send from Outlook. If you use several email accounts with Outlook, create several email signatures. Paper Boat Creative / Getty Images Create a signature
that appends to your outgoing emails in Outlook and makes it a richer experience by adding graphics, animations, and logos. Magictorch / Getty Images If you want to send an email to a group of people but keep their email addresses hidden, send it to "Undisclosed recipients" in Outlook. Winmail.dat is a proprietary Windows format for attachments
that leverages the .dat file generic encoding.If your Outlook program sends attachments as Winmail.dat, it could confuse and concern recipients. Configure Outlook to make sure it does not send winmail.dat attachments to mail recipients. You caninclude your photos, sketches, or other images in the body of your email messagesinstead of as
attachments. These graphics are called in-line images and automatically display in the body of an email message. Use Microsoft Outlook to fetch and send email messages through your Hotmail or Outlook.com account easily and with all the power and flexibility of a desktop email client. Is the font Outlook uses when you compose a message or read an
email too wide, tall, small, big, or blue? Specify the precise font, style, and color to use by default for emails in Outlook. Is the small font used in emails too difficult for you to read? Increase the size of the text in your email messagesin Outlook. Chad Springer / Getty Images Give your emails a colorful and original background in Outlook. Some
recipients may not see this background if their email program is configured to not download or display images or special designs from the internet. Blind carbon copies are used to send copies of the message to multiple recipients without disclosing some of those recipients. This technique lets you send emails to many recipientswithout showing their
names or email addresses to everyone else the message is sent to. Mareen Fischinger / Getty Images Integrate your Google or iPhone Calendar with your Outlook information. Set them up to sync with your Outlook calendar so all of your devices show the same events and appointments. Create your own mailing lists in Outlook and easily send
messages to groups of people. A do-it-yourself list works great for home users who don't have access to a corporate distribution list. If your email, contacts, and calendars areinOutlook, create a backup of that information to make sure you don't lose it if your hard drive crashes or Outlook stops working. Create backup copies of yourPersonal Folders
(.pst) files the files where this information is saved. Creating a backup is as easy as copying the file to a second location. Roy JAMES Shakespeare / Getty Images When you start a new message in Outlook, the default account is the one that automatically determines which settings the signature and the sending email address, for example will be used.
Set the default account when you have more than one account connected to Outlook. Roberto Pangiarella / Getty Images You don't have to choose your favorite message format every time you create a new message. Make your favorite settings your default in Outlook. If you have an email account that you use to back up your messages, or if you need
to copy someone on every message you send, Outlook can automatically send a carbon copy of every message you compose to another email address. If you send a message with an attachment and Outlook won't let you send it because the attachment exceeds some limit, adjust the Outlook attachment size limit. Set the limit to match that of your email
server soemails don't bounce back as undeliverable. Making this change helps avoid unnecessary Outlook errors, too. Keep your contacts even if you leave Outlook behind. If you save your Outlook contacts as a CSV file, you can easily import them elsewhere. visionchina / Getty Images It only takes a few steps to import contacts into Outlook. Then you
can use those contacts to build the basis for a mailing list, for example. Outlook supports imports if the underlying file is a supported type, like a CSV document. Molotovcoketail / Getty Images The search capabilities in Outlook make it easy to find a message when you need it. Creating an All Mail folder for all your messages makes it even easier it's a
great way to create a unified inbox in Outlook. Tell Outlook to deliver a message on or after a certain date. Delayed sending is great for reminders, birthday wishes, and similar items you plan today but won't send until some future date. Epoxydude / Getty Images Make Outlook retain the original message source when it retrieves emails from the
internet. Full headers are useful when troubleshooting a problem or if you need to prove some fact about the receipt of a message. Outlook makes editing received emails easy. Use this technique to adjust subject lines and other important information. Ulf Wittrock / Getty Images Forward the full email and in the state in which you received it as an
EML attachment in Outlook. This preserves all the metadata of the original message, which is useful especially in troubleshooting or legal contexts. Ian Mildon / IanMildon.com Use commas to separate multiple email recipients in a message.By default, Outlook uses semicolons, but you can change the divider to commas if you wish. Unless you have
permanently deleted a message, Outlook retains all the messages from a particular sender in a folder. Use this feature to quickly find themfor reference. Sam Edwards / Getty Images If Outlook remembers an email address you mistyped or if you want to get rid of an outdated name, clear unwanted entries from the auto-complete list that appears
when you type an email address in the To field. Daniel Diebel / Getty Images Recover messages, your address book, calendar, and other essential Outlook data from a backup copy. Restore this important email information from a saved version of your PST file. Zlatko Plamenov / Freepik If you receive emails from a specific sender that you need to file
away for future reference, set up Outlook to send those messages to a specific folder as soon as they are received. Start with a message, then set up an Outlook filter to automatically move all of the sender's future emails to a particular folder. Search the text in a message in Outlook to find a specific word or phrase. If you receive an email with
multiple attachments, don't save them individually. Instead, save all files attached to an email to a folder at once. maxsattana / Getty Images When you want unread messages to stand out, highlight unread mail in Outlook using special fonts, colors, and more. Set your default reply-to address for an email account in Outlook. This technique is useful
when you receive emails from several email addresses associated with the same account. PeopleImages / Getty Images The OS X Address Book application imports Outlook contacts for use in Mac OS X Mail. Baran azdemir / Getty Images If you categorize your contacts, turn your Outlook contacts into elegant, flexible, and stable mailing lists by using
categories instead of distribution lists. www.Asif-Ali.com / Getty Images When you want to send a file along with your email using Microsoft Outlook, attach the file to the email message. Daniel Sambraus / Getty Images When you delete an email in Outlook with certain kinds of accounts, the deleted message may appear grayed out with a line through
it. To permanently erase it, purge the messages marked for deletion in the IMAP folder. To unsubscribe from unwanted mailing lists, you may need to send an email with an old email address you stopped using years ago. When you no longer have access to the old email address, send an email from any address in Outlook. Use keyboard shortcuts to
quickly move emails. It's easy to set up shortcuts to file mail in Outlook. Do you prefer not to have messages open automatically? Do you like the flow of a preview pane-free message list? Here are two ways to disable Outlook's reading pane for all folders, and by default. Lifewire / Ashley Nicole Deleon Change the font style and size of the list of
messages in Outlook to suit your fashion and needs. This tweak helps if you work better with larger type. Use your AOL email accounts with Outlook. Here's how to set up AOL screen name as IMAP email accounts in Outlook. PeopleImages.com / Getty Images If you don't want to constantly purge deleted messages from your IMAP inbox in Outlook
and don't want to see messages that should be gone, hide the messages marked for deletion from view. Set up Outlook to show you total folder message counts. By default, it gives you an unread message count, but you can make it show you a total message count instead. Use Outlook for all your email tasks by configuring Windows to recognize
Outlook as your default email program. That way, the next time you click a mail-to link, Outlook opens. Compose your emails with style and rich formatting in Outlook and make sure that people who prefer or need a plain text version, get it automatically. With so many viruses and malware spread by rich-text or HTML messages, relying on plain text
isn't a bad idea for all your outgoing emails. To forward several emails individually and automatically in Outlook, you need a folder and a rule. Follow these instructions to set up the folder and rule to automatically forwardmultiple emails individually. Your Yahoo Mail account is not made for the web alone. Download mail from a free Yahoo Mail
address into Outlook.And send through Yahoo! Mail, too.Thanks for letting us know!Get the Latest Tech News Delivered Every DaySubscribeTell us why! Microsoft Outlook is mainly known as an email and calendar system, but with a few tweaks you can improve your personal productivity, improve your time management and even perform time
tracking. In this article we explore 10 Microsoft Outlook hacks, tips and tricks to help you use Outlook more effectively.Yes it is! From research we undertook, people that do this report benefits and improvements, including:Improved productivenessimproved time managementReduced stressImproved focus on tasksBetter in office reputationMore free
timeThis may seem counter intuitive, but turning off notifications will actually improve your productivity. Notifications are distractions, they kill your productivity by taking your mind off what you are doing, and sap time when you restart what you were previously doing.It depends on your role at work, but if you can turn notifications off and can
instead look at your email, chat or other systems at regular intervals, your productivity and effectiveness will improve.Go to the File Menu and choose Options > MailGo to the Message Arrival section, and uncheck the Display a Desktop Alert Most of use a to-do list in some form or another to manage our time, and there are many ways to do this in
Outlook.From research we undertook, we found that 23% of respondents use their calendar as a to-do list, 13% use their inbox, 38% use an actual to-do list. As Microsoft Outlook has all of these functions, at least 74% of us can use Outlook for time management. The latest version of Microsoft 365 adds a vertical menu on the left hand side of the
screen, which makes accessing the To-Do list much easier. This is a much welcomed enhancement.The naming convention is still a bit confusing, but to overcome this, think of it like this: just as your Inbox has emails and your Calendar shows appointments, your To-Do list is made up of important Tasks that you need to do.In a busy working
environment, it is easy to get distracted, overlook Tasks and fall behind. A good way to avoid this is to make your To-do list visible in your Inbox:Click on the View tab. In the Layout section of the Ribbon menuNow click on To-Do Bar, and set it to show Tasks (ignore the other options for now)The Task pane will now be displayed to the right of your
email list and will remain visible at all times, which is perfect for managing your To-Do list. You can also add your To-Do list to your diary. To do this:Go to the View Tab and in the Layout area, choose To-Do BarChoose Tasks.Youll now see your full To-Do list to the right of your screen. Instead of having to go back and forth from your Inbox or
Calendar to your To-Do list, adding your To-Do list to your Inbox and Calendar saves time, and helps you keep on top of your Tasks.Youll now see your full To-Do list to the right of your screen.Instead of having to go back and forth from your Inbox or Calendar to your To-Do list, adding your To-Do list to your Inbox and Calendar saves time, and helps
you keep on top of your Tasks.Youll have to get used to glancing over to check your To-Do list, adding Tasks and marking them as complete once done. However, making the effort to form this habit, youll soon see, is worth the effort. Showing your To-Do list in your Calendar and Inbox helps you manage your time better.Although the diary To-Do list
shows all tasks in your list, if you use the Start date (or End date) for Tasks and want to be reminded of tasks on the day they start or end, you can turn on the daily task view.This is actually very handy if you use start or end dates and you should at least try it:Go to the View tabIn the Layout area, choose Daily Task ListChoose the Normal option Youll
now see a daily task list at the bottom of each day. As a default, the Daily Task List arranges tasks by Due Date.This might be fine for you, but if you have a Task which is due next Monday, you wont see it until you get into next week. When using the daily task list and the full to do list, it can be more helpful to arrange daily Tasks by start date. To
change the this:From the Daily Task area at the bottom of your screen, right click on the Show Tasks on: Due DateNow choose By Start Date Now that you have your To-Do list visible in your Inbox and Calendar, its time to start adding tasks.You can create tasks (to-do items) manually, by moving your mouse over a blank area in the To-Do list and
double clicking in the blank space, or by right clicking and choosing New Task). However, you can also create tasks from emails. Tasks often start from emails that you receive, and when they do, they can be quickly turned into Tasks, which is much easier than setting them up manually.To create a Task from an email:Hover over the emailNotice the
red flag icon that appears on the far right of the emailBy clicking on the flag, the email is added as a Task and the flag turns red. A single click sets the email to Follow up Today, and another click sets it to Completed It is all too easy to be interrupted by emails and get side tracked.Now we can see how these tips work together. If you turn off email
notifications (as we showed in 1 above), but check your emails every hour or so, you can review them, and turn important ones into Tasks.By implementing tips 3, 4 & 5, your tasks are visible from your Inbox and calendar, so you can more easily review your Tasks to make sure you focus on the most important and urgent items.Try it!If youve turned
your task pane in emails on already, when you click on the flag the email is flagged as a follow up item and added to your to-do list. If you right mouse click in the flag column, you can choose other follow up dates.Sometimes rather than creating an important follow up as a Task, it may be best to schedule it as an actual appointment. This could be a
follow up call, a meeting, or something that you need to do which needs to occur at a specific date and time. In this case create it as an Outlook appointment.Try It Now! Turn an email into a Task and schedule it as an appointment:Drag the email onto the Calendar icon in the left menu (or bottom menu for older versions) . In a few seconds a new
appointment window with the email as the body text will load. Specify the follow-up date and time, then click Save & Close.Emails can be turned into tasks and appointments, and when you do, the email shows the following message in its heading to show that this email appears in both your calendar and your To-Do list. Research shows that around
90% of us use some of to-do list at work. Weve shown you the mechanics of how to make your To-Do list visible in your Inbox and Calendar. Additionally, weve shown you how to quickly and easily turn emails into Tasks and appointments. Now its time to look at how you can use these tools to help you become more effective and productive, by using
Outlook as a time management system.There are many Time Management techniques (time blocking, eisenhower matrix, pomodoro, eat the frog and more). Time blocking can be used with the Outlook calendar, but the Eisenhower matrix works really well with your Inbox and.What is the Eisenhower Time Management Matrix?The idea of the
Eisenhower Matrix is that by categorizing your tasks by importance and urgency, you can more easily focus on the priority items, and not get held back on less important or urgent items. Quadrant 1 Urgent and Important. These need to be done as soon as possible put them in your To-Do list for today.Quadrant 2 Important, but less Urgent. These can
be scheduled for later add them to your calendar or create them as a Task in your To-Do list to do later.Quadrant 3 Urgent, but not Important. These are important and need to be done, but you have more important items to do, so delegate these to someone else to do.Quadrant 4 Not Important and not Urgent either. Do these really need to be done? If
they dont, delete them. If they do need to be done, then they are either more important or more urgent than you think delegate them to someone else or schedule them to do later.Try it! See if it works for youAs emails arrive, ask yourself is it urgent? and is it important and take action accordingly. Create tasks from emails for Quadrant 1 items,
schedule Quadrant 2 items in your calendar (or as tasks with an end date). Youll quickly see the value of adding your To-Do list to your Inbox (Tip 3) and Calendar (Tip 4). By doing this youll have a shorter, more precise and more focussed To-Do list of important and urgent items, and youll have scheduled reminders for the less urgent items, but most
importantly, there are huge benefits from improved time managements.Benefits of the Eisenhower techniqueFrom research we undertook, these are the benefits people say they get from time management, and you have to admit, these are pretty good returns on investment! If you need to track the time you spend at work, you can use our time
tracking Outlook app. This Outlook hack turns appointments into timesheets and gives you an Outlook time tracking system.If you give the Eisenhower Matrix a try, youll see that your quadrant 2 items (important but not urgent items) flow directly into your timesheet, but you can also track time for non appointment or task items directly.By turning
appointments into timesheets, Timewatchs Outlook time tracking system saves people hours each week. It works with all versions of Outlook, and there is a plugin for Outlook for Windows that adds this functionality inside Outlook so you can track time without ever leaving Outlook. Users can enter manual timesheet entries, which are shown in the
bar at the top of the calendar.These blue Outlook appointments are in the timesheet already and are included in the total time for the day and week.Total per day are shown at the bottom of the screen. They are colored red for days that do not meet minimum hours, and green for days that do.These appointments dont have enough information to be
added to the timesheet yet. They need a customer / project, or a category that has a customer / project assigned. Either takes seconds, and once done, the time is added to the timesheet.Users can configure their timesheets in various formats: Work Week Full Week Bi-weekly MonthlyThe timesheet is designed to look and feel like Outlook, with the
same ribbon menu and calendar, but with timesheet functionality. Appointments in this Outlook calendar, are automatically added to the timesheet on the right.Timewatchs OutlookTime system turns Outlook appointments into timesheets, saving users hours each week and making timesheets more accurate. It also works with Teams and
Google.Timewatch are specialists in managing time in business, from scheduling and planning time, to tracking, billing and analytics of project time. Timewatch develop resource scheduling, time tracking and professional services automation systems, as well as analytics / reporting, time tracking and scheduling solutions for Outlook and Teams. We
work closely with our customers to overcome the limits they come up against in Outlook so that they can continue to use Outlook as a core business tool, but seamlessly integrated with our solutions.Even if you find one of these Outlook hacks of interest, have any questions or want to see how you could use any of these Outlook hacks in your
organization, please contact us. You can contact us via chat, you can also request a call with a product specialist or book a free consultancy call with a systems implementer.Learn more about Timewatch Outlook hacks. 1 Outlook: Tips and Tricks 2 Outlook: Tips and TricksThis will provide you with quick tips and tricks that will help you get organized
using Outlook. Find additional ways to use the , Calendar, Tasks, and Notes features in Outlook Once you understand the basics of how Outlook works you may find that you want to complete tasks more efficiently. This information provides you with quick tips and tricks for organizing your , keeping up with meetings, tasks and more. 3 Objective 1:
Organize Your Email with FoldersCreate folders to categorize and organize your . Method 1 Click the Folder tab on the Ribbon. 2. Select New Folder. 3. Enter a name for the folder in the Name box. 4. From the Folder contains drop down list, select the type of items that will be stored in this folder. 5. Highlight where to place the folder. This means
select the folder one level above where you want the new folder to line up. 6. Click OK. 7. Click and drag the you want to move into the folder you want it to go in. 4 Method 2 1. Right click in the Navigation pane. 2. Click New Folder. 3. Follow steps 3-7 in Method 1. 5 Objective 2: Apply Filters to EmailWhen looking for a particular use filters to ease
your search. From the Home tab, click Filter . 2. Select the category you want to use to filter the inbox. 3. All s that apply to that category will show in the inbox. 6 Objective 3: Create Rules to Reroute MessagesWhen messages are sent to your inbox you can have them automatically moved to a designated folder by creating a rule. 1. From the Home
tab, click Rules. 2. Click Manage Rules & Alerts. 3. Click New Rule. The Rules Wizard will appear. 4. Select the type of rule you want to create. 7 Objective 3: Create Rules to Reroute Messages5. Select the hyperlink people or public group and pick the name or group you want to apply the rule to. 6. Select the hyperlink specified and select which
folder you want it to go to. 7. Click Next. 8. Select the checkbox next to the condition you want to set. 9. Edit the rule description as you did in step 6. 10. Click Next or Finish. 8 Objective 4: Flag Important MessagesAttach a flag to a message to mark its importance or as a reminder to follow up or come back to it. 1. Select the message you want to
attach the flag to. 2. Click the open flag to the right of the message. Once the flag is selected the message will also appear in the task list. Set a Flag with More Detail 1. Right click on the open flag for more option or click Follow Up from the Home tab. 9 Objective 5: Delay the Delivery of an E-mailFrom the Home tab click New . 2. Click the Options
tab. 3. Click Delay Delivery. 4. Choose the settings you want to apply. 5. Check the box next to Do not deliver before. 6. Set the time and date. 7. Click Send. The message will remain in the Outbox until the time you set arrives. 10 Objective 6: Create a Group in your Contacts1. From the Navigation pane, click Contacts. 2. From the Home tab, click
New Contact Group. 3. Type a name for the group in the Name field. 4. Click Add Members. 5. Choose where the members will be selected from. 6. When finished, click Save & Close. 11 Objective 7: Quickly Add Messages to Other Featuresmessages can be easily changed to a calendar appointment or meeting, a task, or a note by clicking and
dragging that message to that particular tool. To Change to a Calendar Meeting 1. Select the you want to add to your calendar. 2. Click and drag that message to the calendar tool in the Navigation pane. A new window will appear showing the set up for a meeting or appointment. 3. Set the criteria. 4. When finished, click Save & Close. To add a
message to a task click and drag to the Task tool in the Navigation pane. To add a message to Contacts, click and drag the message to Contacts in the Navigation pane. To add a message as a note click and drag the message to Notes in the Navigation pane. 12 Objective 8: Schedule a meeting with other peopleA meeting is an appointment that
includes other people and can include resources such as conference rooms. Responses to your meeting requests appear in your Inbox. 1. In Calendar, on the Home tab, in the New group, click New Meeting. Keyboard shortcut To create a new meeting request, press CTRL+SHIFT+Q. 2. In the Subject box, type a description. 3. In the Location box,
type a description or location. If you use a Microsoft Exchange account, click Rooms to choose from available rooms. 4. In the Start time and End time lists, click the start and end time for the meeting. If you select the All day event check box, the event shows as a full 24-hour event, lasting from midnight to midnight. 13 5. In the meeting request body,
type any information that you want to share with the recipients. You can also attach files. 6. On the Meeting tab, in the Show group, click Scheduling Assistant. The Scheduling Assistant helps you find the best time for your meeting. 7. Click Add Others, and then click Add from Address Book. 8. In the Select Attendees and Resources dialog box, in the
Search box, enter the name of a person or resource to include at the meeting. If you are searching with the More Columns option, click Go. 9. Click the name from the results list, then click Required, Optional, or Resources, and then click OK. Required and Optional attendees appear in the To box on the Meeting tab, and Resources appear in the
Location box. The free/busy grid shows the availability of attendees. A green vertical line represents the start of the meeting. A red vertical line represents the end of the meeting. 14 Objective 9: Color Code to CategorizeAll task, calendar, note, and contact items can be color coded to help keep you organize. To Color Code a Calendar Item 1. Click
calendar from the Navigation pane. 2. Choose an existing appointment or meeting or create a new one. 3. Click Categorize from the Ribbon. 4. Choose a color to use. 5. If you choose, rename the category. If not click No. To Remove a Color Coded Category 1. Open the item you want to remove the color code from. 2. Double click on the colored bar. 3.
Uncheck the box next to the color that was chosen or click Delete. Follow the steps above to color code tasks, notes, and contacts. 15 outlook 2010 Tips and TricksThe Tips and Tricks covered here were picked to help you increase your productivity with Microsoft Outlook The purpose of this session was to brush aside the technical mumbo-jumbo, and
get straight to what can truly save you time. If you use a computer at work, you probably use Microsoft Outlook like millions of people around the world. It was created in 1996 as Hotmail but launched as Outlook by Microsoft in 2012. Its one of the most popular email and calendar productivity platforms around. But few people really know and use all
of Outlooks features. Learning about all of Outlooks capabilities and how to use them will really up your productivity game and help you get better organized and work more effectively. Did you know that you can add a second time zone to your Outlook calendar? This makes working with international clients or co-workers (or family members for your
personal emails) much easier to schedule calls and video conferences. Its set in File/Options/Calendar Time Zones, and after setting, the second time zone is visible in day or week mode on the left side of the calendar. You can learn all about Outlook productivity hacks in books like Total Workday Control Using Microsoft Outlook by Michael
Linenberger and Microsoft Outlook 2019 for Dummies by Faith Wempen, M.A. and Bill Dyszel. But start using the following nine Outlook productivity tips and tricks right now and see what a difference it will make in your day to day organization and work success. Do you get distracted by frequent email notifications about incoming emails? Do you
feel compelled to check emails as soon as you see notifications? How many times do you open emails from notifications only to find some unimportant message or a marketing email that you just delete? Adobes survey found that respondents spend 209 minutes checking email at work. Thats a lot of time out of the work day looking at messaging. You
need this Outlook productivity hack to help. You can limit those incoming notifications so you only get notified about the most important emails from specific people that you designate. That way you only get notifications for emails that really do need your immediate attention. Cut through distracting incoming notifications all day long and take control
in Mail Options. Turn off all desktop alerts and create a rule to display alerts for messages from people you specify. Now youll have far fewer pop-ups for incoming emails and can set a time to check your general inbox when its convenient to you. Read More: Top Strategies for Prioritization and Time Management at Work One of the best Outlook
productivity hacks is shortcuts. Use shortcuts to save time when youre in Outlook. Instead of going to the menu ribbon to find the feature you need, try these: To reply to an email hit Ctrl + R. To create a new email hit Ctrl + Shift + M To open your email hit Ctrl + 1 To open your calendar hit Ctrl + 2 To open your contacts hit Ctrl + 3 To create an
appointment hit Ctrl + Shift + A To create a contact hit Ctrl + Shift + C Tired of getting to the end of projects and stressing about missed steps or outstanding tasks? Let Outlook ease that stress and keep you on point by scheduling check-in reminders in Outlook calendar for tasks that need completion at points before your project delivery deadline.
Dont set reminders only for the deadlines; use them for benchmarking important steps on the way to your project completion. Schedule check-in reminders for your own tasks in calendar rather than just the start and end dates for projects. And if you work in Office 365, you can use Planner for charting progress against deadlines and revise and refine
team tasks to stay on track. Use Outlook reminders for regular tasks you get distracted from, so you dont let them slip by undone. Or set reminders to get up from your chair, give your eyes a break from screen time, or do ergo exercises to protect your wrists and back. Read More: 26 ChatGPT Productivity Prompts to Reduce Hours of Work in Minutes
If youre like most Outlook users, you have a long list of folders where you file your incoming emails to refer back to if needed and to have documentation on communications and information received. You probably also have many many emails that arent worth saving that you only quickly read through and then move on, emails that arent even
specifically yours but which you are included on. Are you tired of sifting through endless email threads when you are carbon copied on messages? How much time do you spend skimming through and sorting or deleting these messages? Do you dread your inbox when returning from vacation or after a few days off? Have you checked your email on
vacation because you didnt want to get too far behind and return to work to an overloaded inbox? Need a better way? Create an Inbox CC folder to divert all emails that you are only ccd on, not addressed directly to you. That de-clutters your inbox and makes it easier for you to focus on more important and relevant emails first. Set up this folder in
Rules by selecting Create Rule, then Advanced Options. In the Rules Wizard, click the item where my name is not in the To box then on the next screen, move it to the specified folder. Image from extendoffice.com Writing notes to help remember things is a staple of work and personal life. Do you rely on paper sticky notes at your desk for important
dates, contact numbers, and emails? Did you know you can take your sticky note game on line with Outlooks sticky notes feature? Clear your desk of paper notes and load them into Outlook for a more efficient reminder system at your fingertips. Its pretty simple by pressing Control/Shift/N anywhere within Outlook to create a sticky note you type your
reminder onto. Drag and drop and place your sticky note anywhere on your screen. Organize your notes, or give yourself an extra visual clue by using different colored notes. Change the colors of sticky notes, and categorize notes by color for even more awesome organization. And by clicking on the Note icon at the bottom of the View pane, manage
sticky notes by copying, printing, and searching for notes with the field at the top-right of the window. Read More: 12 Calendar Management Tips for Executive Assistants How often do you try to work on multiple things at one time? Have you ever done any of these: Checking emails while on the phone with a client? Watching a training video while
writing a report? Creating a presentation while reviewing team stats? While multitasking may be a fact of modern life, its stressful and doesnt always produce the best results. If you need some quality time with no interruptions to work on important tasks or projects, Outlook can help with that. Add blocks of time in your Outlook calendar where you
are unavailable for meetings. Schedule time blocks to work on specific tasks and see how your productivity improves. Image from enee.com.au If you find yourself frequently going back to important emails for information or to re-read for understanding, you may want to create search folders. Instead of scrolling through emails from your boss or team
members, save the search term to get to the emails you need more quickly. Go to the left navigation menu and right click on Search Folders. Then select New Search Folder and you can manually customize the search or use the wizards. When every minute of your day is scheduled, and you have many competing tasks and deadlines to pay attention
to, Outlook can be your best friend, your personal assistant, and your productivity secret. And it is always improving features for users. Outlook Insights is available to users with a MyAnalytics user license as an add-on. Internet Explorer 10 or 11 is required. Outlook Insights reminds you to reserve time to focus when your calendar is packed, lets you
add names of people that you need to prioritize for communications and meetings, and shows you outstanding tasks that need attention. Insights has a quick link to MyAnalytics, so you can easily see how your time is spent and make adjustments if necessary. 8 View FilterPicture this: You just got back from a fun vacation. Youre feeling good and ready
to get back to work. You turn on your computer and open your email. Whoa, your inbox is flooded with many new messages! While you were gone, your coworkers sent a lot of emails and included you on all of them. Now, you feel overwhelmed and dont know what to do.Dont worry, theres a quick and easy Microsoft Outlook hack to help clean up your
inbox. Its all about using the Filter function in the View tab.Here are quick steps you can follow:Go to the View tab at the top.Then click on Current View and View Settings.Find the Filter option and click on it. At first, its set to Off, but you can change that.This Filter option is cool because it is easier to find important emails and lets you focus on
these. Maybe you want to see only emails from your boss or from a special customer. Just set the filter to show you emails from that person.You can also use a filter called Where I am. This shows only the emails that were sent only to you. These might be emails that you need to do something about right away. By using this filter, you see only these
emails. Maybe you need to reply to them or do something else they ask you to do. And thats not all. There are many other ways you can use filters to help you deal with lots of emails. Its a handy tool that can make things a lot easier for you. So, next time you come back from a vacation and find lots of new emails waiting for you, youll know what to
do!9 Insert Frequently Used Phrases Or Blocks Of TextIf you find yourself frequently writing the same information over and over, its time to explore this handy tool called Quick Parts.Microsoft Outlooks Quick Parts is an excellent tool to help you write repetitive content and improve productivity. To create Quick Parts, write the text you often use and
select it. Next, navigate to the Insert tab on the ribbon, then click Quick Parts followed by Save Selection to Quick Part Gallery. Assign a memorable name and save it. Now youre ready to use your Quick Part! When composing individual emails, navigate to the Insert tab, then Quick Parts. From the list that appears, choose the Quick Part you wish to
include. If you remember the name, simply start typing it in the email body, and press Enter when the tooltip appears.With Quick Parts, you can file frequently used responses, graphics, tables, or mixed content, saving time and ensuring consistency in your Outlook communications.If the Quick Parts feature is hidden in your Outlook, you can add it to
your ribbon for fast and easy access. You open a new email, then click on Insert > click > Right-click Quick Parts > Select Pin to Ribbon. If you havent been using all of Outlooks email and time management features, its time to start paying attention to all the productivity tools for Outlook. You will soon use Outlook like a pro! A: Some tips to increase
productivity using Outlook include: creating a to-do list, using the scheduling assistant, organizing emails into folders, setting up automatic replies, using the Quick Steps feature, and cleaning up your inbox. A: You can automatically file incoming mail in Outlook by setting up rules. To do this, select an email that you want to automatically file, then
click on the Rules button and select Create Rule. From there, you can set up rules based on the sender, subject line, or other criteria. A: You can clean up your inbox in Outlook and manage your emails more efficiently by using the Folder System to create folders for different types of emails, setting up rules to automatically file email, and using the
Quick Steps feature to automate repetitive tasks. A: You can use the Outlook calendar to improve your productivity by scheduling appointments and reminders, setting up recurring events, and using the scheduling assistant to find the best time for meetings. You can also view your calendar in a number of different ways, such as by day, week, or
month. A: Some other tips and tricks to help you manage your tasks in Outlook include using the Tasks feature, setting up alerts and reminders, and using the Category function to organize your tasks. You can also use third-party tools and plugins to further customize your Outlook experience. Related Articles: PPTXTimesheet Workshop: The
Timesheet App People Love!OdooPPTXWhat is Microsoft Enterprise Mobility Suite and how to deploy itPeter De TenderPPTXOdoo introductionhdarabiPPTXHow to deploy Exchange Online ProtectionPeter SchmidtPDFOdoo Implementation MethodologyOdooPPTXAgile Values, Principles and PracticesjackcrewsPDFOdoo - Vision &
StrategyOdooPPTXOutlook 2016 trainingAli MkahalPDFIntorduction to DatapowerShilpin Pvt. Ltd.PPTXManufacturing erp with odoo (odoo mrp)Celine GeorgePDFClean architecture - Protecting the DomainVictor RenteaPPTXOdoo Presentation 2020 - EN.pptxAsad Nawaz Khan PMP, CMAPDFIntroduction to ERPNext

(2015)rushabh _mehtaPPTXIntegration with dynamics ax 2012Ali Raza ZaidiPPTXOdoo Presentasi.pptxYudi512144PPSXMicrosoft Office 365 PresentationSNP Technologies, Inc.PDFBest Practices for Adopting Microsoft Dynamics 365PreciselyPDFLogicalDOC - Convenient and easy document management systemLogicalDOCPPTXMicrosoft
Teams]igger PerezPDFIntroduction to Microsoft 365 EnterpriseRobert CranePPTXMicrosoft One Note Tutorial JoshuaDsouza31PPTXLeading Practices in Multi-Pillar Oracle Cloud ImplementationsAlithyaPDFOffice 365 migrationMotty Ben AtiaPPTXMicrosoft Teams in the Modern WorkplaceJoanne KleinPPTXBusiness Process Management
SoftwareKissflowPPTXIntroduction to Power PlatformPraveen NairPPTXMicrosoft Outlook Tips Hints For Adminspses12Are you wanting to take your Outlook 365 game up a notch? In today's rapidly evolving digital workspace, it pays to stay ahead of the curve and know the best tips and tricks that will help you get the most out of Outlook.If that
sounds like something you could benefit from, then stick around for our comprehensive Outlook 365 tips and tricks guide for 2024!Here we'll be giving you some expert advice on how to use Outlook smarter, faster, more efficiently as well as some hidden features everyone should know about.So, keep reading if you're ready to unlock all the potential
this powerful tool has to offer!5 New Outlook 365 Tips 2024 UpdatedHere are the latest outlook 365 tips of 2024 updated:1. Streamline Email & Calendar in one Appln 2024, the latest update of Microsoft Outlook is that you can now streamline emails and calendar in one app.With Outlooks user-friendly interface, you can effortlessly manage your
schedule, communicate with others, and stay organised throughout your day.If you use Outlook, Hotmail, Gmail, Yahoo, iCloud, or any provider that supports IMAP, you can easily add multiple accounts and access all your calendars in a single view.You can now seamlessly toggle between accounts to read emails and manage contacts.2. Write Better
Emails with AIThe new Outlook app comes equipped with Al capabilities to help you craft top-notch emails.Now say goodbye to long-winded sentences and pesky errors, thanks to intelligent spelling and grammar checks.Also, if you have a Microsoft 365 Personal or Family subscription, you will unlock access to advanced Al writing tools through
Microsoft Editor.3. Connect Seamlessly to Microsoft 365 AppsThe new Outlook effortlessly syncs with free Microsoft Word, Excel, and PowerPoint web apps, providing you with the convenience of quick edits and comments.Also, you can directly access and attach OneDrive files right from your inbox.4. Tools to Keep You Organised4.1 My Day View To
DoWith Microsoft To Do in the My Day view, you'll have a comprehensive overview of your upcoming calendar events and tasks, accessible from anywhere.Plus, you can automatically sync package delivery details, upcoming travel dates, and even the weather forecast right into your calendar from email confirmations.Source: Pin Your EmailsDid you
know that you can make your emails more organised and efficient?By pinning emails to the top of your inbox, you can easily find them later.If you're not ready to respond to certain emails, you can snooze them and have them pop back up when you're ready to tackle them.And to ensure you never miss any important conversations, you can set
reminders to follow up.4.3 Schedule Email Sends to Deliver at the Best TimeYou can schedule your email sends to arrive at the optimal time for the recipient or even undo a sent email within a mere ten seconds.It's a nifty feature that ensures your emails are timely and allows for quick fixes if needed.4.4 Clean the Inbox with Sweep FunctionFor a
quick and efficient way to clean up your inbox, utilise the sweep function.By setting advanced inbox rules for incoming mails, you can easily manage and organise your email.5. Customise Your InboxNow, you have the freedom to choose the perfect Outlook view that matches your mood and style.With over 50 themes and 150+ fonts available, you can
truly make it your own.In addition, enjoy the flexibility of adjusting the number of emails displayed in your inbox with roomy, cosy, and compact view options. Outlook 365 Tips and TricksHere are the latest Microsoft Outlook 365 tips for 2024:6. Use the Outlook Calendar to Schedule MeetingsOutlooks calendar feature is a great way to schedule
meetings quickly and easily with colleagues, clients, or other contacts.You can create an event and then invite attendees with just a few clicks.There are also options for adding reminders, setting recurrence patterns, and attaching files to the event.7. Utilise the Focused Inbox FeatureThe Focused Inbox feature in Outlook 365 can help you stay
organised by separating your emails into two tabsone for important messages that need immediate attention and one for less urgent messages that can be addressed later.This feature can save you time by allowing you to focus on the most important emails first.8. Take Advantage of Quick StepsQuick Steps are pre-configured actions that you can use
to quickly complete common tasks in Outlook such as replying to a message, forwarding it, or flagging it for follow-up.You can customise Quick Steps so that they perform multiple actions in one step, which can save you time when dealing with large volumes of emails.9. Set Up Rules for Automated Email ProcessingRules allow you to automate certain
tasks in Outlook such as moving certain emails to specific folders or sending automatic replies based on keywords in the subject line or body of an email message.You can also set up rules for filtering out spam messages or deleting messages after a certain period of time has passed.10. Create Categories for Easier OrganisationCategories in Outlook
allow you to organise your emails into color-coded groups so that they are easier to find and manage.This is especially useful if you get a lot of emails from different sources and need an efficient way of sorting them into related groups.11. Take Advantage of Conversation ViewConversation view allows you to see all messages within a particular thread
at once instead of having to search through individual emails one at a time.This makes it easier to keep track of conversations and quickly find what you are looking for without having to go through multiple messages manually.12. Use Search Folders for More Efficient SearchesSearch folders allow you to store searches so that they can be accessed
more quickly than running them each time from scratch using the main search bar in Outlook.This is especially useful if there are certain searches that you run frequently such as searching by sender name or date rangeyou can save these searches as search folders and access them whenever needed without having to re-enter the criteria each time
manually.13. Utilise Advanced Find FunctionalityThe advanced find functionality in Outlook allows users to search their mailboxes using more specific criteria than whats available via the main search bar interface (e.g., searching by attachment type).This is useful if there are certain types of emails that need locating quickly without having to sift
through hundreds (or thousands) of results manually.14. Use Flags to Mark Important MessagesFlags are another great way of keeping track of important messages within your mailbox so that they don't get lost among all the others vying for your attention!You can set flags on individual messages or whole conversations and then use filters and
views later on down the line when trying to locate them again.15. Set Up Notifications for When New Mail ArrivesSetting up notifications will alert you when new mail arrives in your inbox so that nothing slips through unnoticed!You can choose whether these notifications appear as pop-ups, banners, or sounds depending on how intrusive/discreet
you'd like them.16. Take Advantage of Keyboard Shortcuts to Speed Things UpKeyboard shortcuts allow users to quickly perform common tasks such as creating new items (Ctrl+N), replying (Ctrl+R), forwarding (Ctrl+F), etc., without having to navigate through menus every single time.More keyboard shortcuts:Create a new email - Press Ctrl +
Shift + MNew Contact Ctrl + Shift + CAppointments Ctrl + Shift + AMeeting Request Ctrl + Shift + QSend message Ctrl + EnterReply to an email Ctrl + RReply to all Alt + RForward email Alt + WSend/Receive all Ctrl + M: F9Send email Alt + SCalendar ShortcutsSwitch to work week in calendar view Alt + RSwitch to weekly calendar view Alt +
WOpen the go to date dialog to jump to any date in the calendar Ctrl + G17. Customise Your Signatures for Different Accounts or ContactsSignatures provide an easy way for users to identify themselves when sending out emails; they also make it easy for recipients to know who sent them which message(s).By customising signatures per
account/contact group, users not only make their communications look professional but also ensure their intended recipients know exactly who sent what.18. Create Contact Groups to Send Bulk Emails EasilyContact groups make it easy to send bulk emails out in masses; rather than entering each recipient's address individually every single time,
users simply select their contact group(s) from the dropdown list upon composing their message(s) - saving loads of time!19. Integrate Other AppsYou can integrate other apps such as Evernote and Trello into Outlook 365 for an even more powerful experience.This allows you to access all of your favourite tools from within Outlook 365, making it
easier than ever before to stay organised and on top of tasks without having to switch between multiple apps or websites.20. Create TasksTasks are a great way to keep track of all of the things you need to do each day without having them clog up your email inboxes or calendar views through Microsoft To Do.You can easily add tasks directly from
emails, assign them due dates, set reminders, and prioritise them according to importance so that nothing falls through the cracks!21. Get Creative with TemplatesCreating templates is another great way to save time when sending out repetitive messages such as meeting invitations, or thank-you notes simply create a template with all the necessary



details already filled out then customise it for each individual recipient instead of typing out everything from scratch every single time!22. Schedule Time For YourselfScheduling blocks of "me" time throughout each day is essential for achieving balance - whether it's taking a break from work for lunch/coffee breaks, going for walks in nature during
lunchtime etc., these moments will help recharge your batteries & give you much needed perspective during stressful times!23. Create Filters to Sort EmailsFilters allow you sort incoming emails according to specific criteria - this makes finding important messages much easier & saves time scrolling through hundreds/thousands of unimportant ones
- some popular filter criteria include sender name/address/domain name etc.24. Save time with Quick PartsCreate Quick Parts for default responses to common questions, frequently sent emails and more.Highlight the text you want to save in the body of the email and click insertClick Quick Parts and select Save Selection to Quick Part GalleryGive
the text a name and add a descriptionHow to use:Click inside the body of the emailClick insertClick Quick Parts and select the Quick Part you want to insertVoila! The pre-written text will appear in your email, which can be edited and customised if needed.25. Multiple Time ZonesIf you work across multiple time zones and always check google for the
time, Outlook can help by showing two or three time zones in your calendar at the same time.Go to: File Options Calendar Time Zones Show a second time zoneBoth times will show in your weekly view.
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